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1 Introduction to the CellASIC® ONIX Microfluidic System
1.1 Overview

The CellASIC® ONIX Microfluidic System uses microfluidic technology for continuous 
media flow control and switching to enable live-cell analysis experiments. The proprietary 
design allows cells to be exposed to different solutions and conditions via pressurized flow 
channels controlled by user-specified time intervals and flow rates.

The microfluidic plate can be used with typical inverted microscopes and fits a standard 
multiwell plate stage. The CellASIC® ONIX Microfluidic System connects to the microfluidic 
plate via a pneumatic manifold that uses pressurized air to pump cells and liquids from 
the plate wells into the microfluidic cell culture chambers. A vacuum seal created between 
the manifold and the microfluidic plate ensures that each well is independent and that 
flow rates and fluid switching are accurate. Flow control is managed through a computer 
software program.

NOTE: The CellASIC® ONIX FG Software does not control, nor is it controlled by, image 
acquisition software or the microscope itself.

This user guide covers the setup and operation of the CellASIC® ONIX Microfluidic System 
(EV262), Microincubator Controller (MIC230), and Tri-Gas Mixer (GM230). User guides for 
the CellASIC® ONIX Microfluidic Plates are available at www.millipore.com/cellasic. 

Micro�uidic Perfusion System

Vacuum Power Ready Sealed To Micro�uidic Plate

Figure 1.  CellASIC® ONIX Microfluidic System setup

NOTE: Microscope function and 
image acquisition are not 
integrated with or provided 
by the CellASIC® ONIX FG 
Software.

1.2 Benefits
 ● The CellASIC® ONIX Microfluidic System provides a total solution for controlling 
the perfusion and gas environment which can enable time-lapse, live-cell analysis 
experiments.

 ● The CellASIC® ONIX FG Software automates the culture and cell environment 
throughout the entire experiment, allowing scheduled flow changes without 
supervision. Customized experiments can be performed by programming changes to 
media solutions, flow rates, and the duration of each step. The easy-to-use software is 
flexible and can generate simple solution-switching protocols or advanced flow profiles.

http://www.millipore.com/cellasic
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 ● The precision laminar flow maintained by the system creates a highly stable 
environment for cells. The CellASIC® ONIX Microfluidic System requires only microliter 
volumes of fluid and can run for multiple days without refilling.

1.3 Environmental Control
There are several temperature and gas control options for the CellASIC® ONIX Microfluidic 
System. Please contact Technical Service for assistance in selecting the one that will work 
best with your specific setup and experiment.

If you already have or do not require temperature control, a defined gas environment 
can be delivered to the cell culture region by simply attaching a gas line flowing the 
desired gas mixture to the white Luer fitting on the manifold tubing. You can supply 
your own mixed gas (the gas must be at atmospheric pressure and regulated to a flow 
rate of 3–100 mL/min), or use the CellASIC® ONIX Tri-Gas Mixer. Refer to section 9 for 
information on using the Tri-Gas Mixer.

Figure 2.  Manifold and plate cutaway 

Manifold

Gas permeable membraneCells

Air pressure-driven flow

Gas mixture (0–10% CO2)

Microfluidic plate

The CellASIC® ONIX Microincubator Controller and CellASIC® ONIX Microincubator Manifold 
allow you to control both temperature and gas. This environmental control system takes 
advantage of the small size of the culture volume to efficiently, accurately, and conveniently 
maintain a precise cell culture environment. Refer to section 8 for information on using the 
Microincubator Controller and Manifold.

1.4 Applications
The CellASIC® ONIX Microfluidic System is perfect for any perfusion-based application. The 
following are some common applications:

 ● Cell cycle analysis  ● 3D deconvolution

 ● Protein localization  ● Cell migration

 ● GFP/CFP/YFP expression  ● Long-term time-lapse studies

 ● Kinetic responses to solution change  ● Apoptosis

 ● Cell fixing and immunostaining  ● Mitosis

1.2 Benefits, continued 
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1.5 CellASIC® ONIX Microfluidic Plate and Cell Type Compatibility
The Microfluidic Plates incorporate design templates that provide compatibility with a 
range of cell sizes and types as follows:

M04 Series Microfluidic Plates are compatible with any adherent or non-adherent 
mammalian cell line capable of culture on glass.  
Examples: MCF-7, HeLa, NIH3T3, PC3, primary cells, stem cells

Y04 Series Microfluidic Plates are compatible with non-adherent cells that are  
3.5–7 µm in diameter. 
Examples: S. cerevisiae, S. pombe

B04 Microfluidic Plates are compatible with non-adherent cells that are  
0.7–4.5 µm in diameter. 
Examples: E. coli, B. subtilis, cyanobacteria

C04 Microfluidic Plates are compatible with non-adherent flagellates. 
Example: Chlamydomonas

Please contact Technical Service for questions about cell types or coatings.

1.6 Product Use Limitations
The CellASIC® ONIX Microfluidic System, Microincubator Controller, Tri-Gas Mixer, and 
Microfluidic Plates are intended for research use only. They are not for use in diagnostic 
procedures.

All due care and attention should be exercised in the handling of the products. Instructions 
provided in this manual should be followed when using CellASIC® ONIX products.

If the equipment is used in a manner not specified by the manufacturer, protection 
provided by equipment may be impaired and the warranty may be voided.

2 Components Required
The following components for a functional system are included in the CellASIC® ONIX Microfluidic 
Platform package. Refer to the Product Ordering section for additional manifolds, accessories, and other 
components.

Component Catalogue Number
CellASIC® ONIX Microfluidic System EV262

CellASIC® ONIX Manifold F84-GL4

CellASIC® ONIX FG User Interface Software (USB Drive) 0NIX-FG-SW

Accessory box for CellASIC® ONIX EV262 Microfluidic System  
(includes diagnostic plate, syringe Luer adapter, input fittings, 8-pack 
replacement Luer filters)

ABN2
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3 Symbols Used in this User Guide / 
Symboles utilisés dans ce manuel d’utilisation

The following symbols are used throughout this user guide and/or on product labels, and the user shall 
abide by indicated requirements:

Les symboles suivants sont utilisés tout au long de ce manuel d’utilisation et/ou sur les étiquettes des 
produits ; l’utilisateur devra respecter les exigences indiquées :

Symbol / Symbole Definition Définition

Y
Warning alerts you to actions that 
may cause personal injury or pose a 
physical threat.

“Attention” vous alerte à propos des 
actions qui risquent de blesser quelqu’un 
ou de constituer une menace physique.

Federal Communications Commission 
(FCC) conformity marking 

Marquage de la conformité avec 
la Commission fédérale des 
communications américaine (FCC pour 
Federal Communications Commission).

Canadian Standards Association® 
(CSA) conformity marking

Marquage de la conformité avec 
l’Association canadienne de 
normalisation (CSA pour Canadian 
Standards Association®)

C
CE conformity marking. Reference 
Declaration of Conformity for specific 
directives.

Marquage de la conformité CE. 
Déclaration de conformité à certaines 
directives pour référence.

Do not discard with common solid 
waste at end of life. Segregate with 
other waste electrical and electronic 
equipment (WEEE) and send to an 
appropriate facility for recycling. For 
information on recycling electrical 
and electronic products in the 
European Union, please visit  
www.millipore.com/weee.

Ne pas jeter avec les déchets solides 
communs en fin de vie. Mettre à part 
avec les autres déchets d’équipements 
électriques et électroniques (DEEE) et 
envoyer à une entreprise habilitée pour 
recyclage. Pour une information sur le 
recyclage des produits électriques et 
électroniques dans l’Union européenne, 
veuillez consulter la page  
www.millipore.com/weee sur Internet.

http://www.millipore.com/weee
http://www.millipore.com/weee


CellASIC® ONIX Microfluidic Platform 5

4 Product Labeling

Figure 3.  Product labels appear on backs of the components

B

EV262 label MIC230 label

B

GM230 label

5 Safety Precautions / Précautions de sécurité
Review and understand the safety precautions below before installing and operating the CellASIC® 
ONIX Microfluidic System and Microincubator Controller.

Lire et comprendre les précautions de sécurité ci-dessous avant d’installer et de faire fonctionner le 
Système de microfluidique CellASIC® ONIX et le Régulateur du microincubateur.

Y  WARNING Y  ATTENTION
To avoid danger of electric shock, do not install 
the system in an area with a high humidity level. 
Refer to Site Requirements in section 6.

Pour éviter le risque de choc électrique, ne pas 
installer le système dans une zone où le taux 
d’humidité est élevé. Se reporter au paragraphe 
“Site Requirements” (Exigences relatives au lieu 
d’installation) de la Section 6.

Do not touch the cables or power plugs with wet 
hands.

Ne pas toucher les câbles ou les prises électriques 
avec des mains mouillées.

To avoid potential shock hazard, use the correct 
plug configuration and make sure that the power 
cable is plugged securely into a properly grounded 
AC power outlet. Make sure that the connection 
between the cable and the instrument is secure.

Pour éviter le risque potentiel de choc, utiliser 
la bonne configuration de prise et s’assurer que 
le câble électrique est solidement branché dans 
une prise de courant correctement reliée à la 
terre. S’assurer que la connexion entre le câble et 
l’instrument est sécurisée.

Always ensure that the power supply input 
voltage matches the voltage available in your 
location.

Toujours s’assurer que la tension du courant 
d’alimentation de l’instrument correspond bien à 
la tension disponible sur place.

Use only the power cables supplied by EMD 
Millipore Corporation for use with the CellASIC® 
ONIX Microfluidic System and Microincubator 
Controller. Use of other power cables may damage 
the system.

Utiliser uniquement les câbles électriques 
fournis par EMD Millipore Corporation 
pour une utilisation avec le Système de 
microfluidique CellASIC® ONIXet le Régulateur 
du microincubateur. L’utilisation d’autres câbles 
électriques pourrait endommager le système.
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Y  WARNING Y  ATTENTION
Minimize power draw from other instruments on 
the same power circuit.

Minimiser la consommation de courant par 
d’autres instruments branchés sur le même 
circuit.

Do not use with flammable or explosive liquids. Ne pas utiliser avec des liquides inflammables ou 
explosifs.

Before cleaning and moving the system, always 
turn off power and unplug power supply.

Avant de nettoyer ou de déplacer le système, 
toujours l’éteindre et le débrancher.

When working with biological material, always 
wear a suitable lab coat, disposable gloves, and 
eye protection. Proper lab safety should always be 
followed when using the system.

Lorsque vous travaillez avec des matières 
biologiques, toujours porter une blouse de 
laboratoire, des gants à usage unique et une 
protection oculaire adéquats. Il convient de 
toujours suivre les mesures de sécurité au 
laboratoire appropriées lors de l’utilisation du 
système.

FCC statement: This equipment has been 
tested and found to comply with the limits for 
a Class A digital device, pursuant to part 15 
of the FCC Rules. These limits are designed 
to provide reasonable protection against 
harmful interference when the equipment is 
operated in a commercial environment. This 
equipment generates, uses, and can radiate 
radio frequency energy and, if not installed 
and used in accordance with the instruction 
manual, may cause harmful interference to radio 
communication. Operation of the equipment 
in a residential area is likely to cause harmful 
interference, in which case the user will be 
required to correct the interference at his own 
expense.

Déclaration FCC : Cet équipement a été testé et 
s’est avéré conforme aux limites pour un dispositif 
numérique de la Classe A, conformément à 
la Section 15 du Règlement FCC. Ces limites 
sont conçues pour assurer une protection 
raisonnable contre les interférences préjudiciables 
lorsque l’équipement est exploité dans un 
environnement commercial. Cet équipement 
génère, utilise et peut émettre de l’énergie 
à radiofréquences et, s’il n’est pas installé et 
utilisé conformément au manuel d’instruction, 
peut provoquer des interférences préjudiciables 
pour les communications radio. L’utilisation 
de l’équipement dans une zone résidentielle 
est de nature à provoquer des interférences 
préjudiciables, auxquelles l’utilisateur devra 
remédier à ses frais.

CSA statement: This Class A digital apparatus 
complies with Canadian ICES-003.

Déclaration CSA : Cet appareil numérique de 
Classe A est conforme avec la norme canadienne 
ICES-003.

5 Safety Precautions / Précautions de sécurité, continued
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6 Installation
6.1 Packaging

Inspect the packaging for damage upon receipt. If there are any signs of damage, contact 
the responsible shipping company.

Y  WARNING Y  ATTENTION
Do not put system components showing 
signs of damage into operation as this 
may result in severe personal injury and/or 
property damage.

Ne pas mettre en marche des composants 
du système présentant des signes de 
dommages, car cela pourrait provoquer 
des blessures corporelles graves et/ou des 
dommages matériels.

NOTE: Instruments will not be accepted for repair if not in original packaging. EMD 
Millipore Corporation will provide shipping boxes for a charge if original packaging 
has been discarded.

6.2 Site Requirements
The CellASIC® ONIX Microfluidic System and Microincubator Controller are designed for 
indoor laboratory use. The user must provide an installation site that meets the following 
requirements:

Space requirement Stable and horizontal base able to bear the weight of 
microfluidic system components and user-provided 
components

Allow sufficient space so as not to block the ventilation holes 
on the sides and front of the system.

Environment Temperature range: 20–30 °C 
Keep away from bright sunlight and high humidity (< 80%).

Inductive electrical 
interference

Do not install the CellASIC® ONIX Microfluidic System or 
Microincubator Controller near any sources of potential 
inductive electrical interference (e.g., pumps, switching 
motors, microwave ovens, etc.), sources of high energy pulses, 
or sources that might cause magnetic or radio frequency 
interference.

Power supply Voltage range: 100–240 VAC

Frequency range: 50/60 Hz

Connect the CellASIC® ONIX Microfluidic System and 
Microincubator Controller only to a grounded power outlet.

Take precautions to ensure uninterrupted power supply if there 
is the potential for power supply issues (e.g., brownouts, power 
surges, frequent thunderstorms, etc.)
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6.3 Software Installation
In order to run this software, your computer must meet the requirements outlined below:

Windows® XP, Windows® 7, Windows® Vista, or Windows® 8 operating system
1 GB RAM or higher
200 MB hard drive space or higher
Keyboard, mouse
USB port

To install the CellASIC® ONIX FG Software onto the computer, insert the provided USB 
drive into the USB port on the computer. If automatic installation does not begin, open the 
folder containing the software and click on ONIX FG Installer→setup.exe. An installation 
wizard guides you through the installation of the software. Simply follow the prompts.

NOTE: Drivers for the Microfluidic System and Microincubator Controller typically install 
automatically when the systems are connected by USB and powered on. If a 
connection is not established automatically, the driver can be installed manually as 
follows: 

1. Go to Control Panel→Device Manager.

2. Right click device UM232R USB<->Serial and select Update Driver Software. 

3. Select Browse my computer for driver software, point the driver search at  
C:\Program Files\CellASIC ONIX FG and click Next.

4. After the driver is installed successfully, right click device USB Serial Port and 
select Update Driver Software.

5. Again, select Browse my computer for driver software, point the driver search 
at C:\Program Files\CellASIC ONIX FG, and click Next.
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6.4 CellASIC® ONIX Microfluidic System Setup
For Microincubator Controller and/or Tri-Gas Mixer setup, refer to sections 8 and 9.

Remove all components from shipping boxes and lay out on work surface.

1. Place the CellASIC® ONIX Microfluidic System within 1–2 meters of an inverted 
microscope. For best results, locate the system on a flat surface and secure the 
manifold tubing so that it does not hinder stage movement. Ventilation holes on the 
front and sides of the system should not be obstructed.

2. Connect the power cord from a grounded electrical outlet to the system (D in Figure 4). 
The internal power supply accepts any voltage source between 100 and 240 VAC. 
Connect the USB cable from the computer to the USB port (A in Figure 4) on the back 
panel of the system.

Y  WARNING Y  ATTENTION
To avoid personal injuries and/or property 
damage caused by electrical power, 
connect the system and computer to 
a grounded power outlet. Make sure 
that this power outlet complies with 
IEC (International Electrotechnical 
Commission) regulations.

Pour éviter les blessures corporelles et/
ou les dommages matériels causés par le 
courant électrique, brancher le système 
et l’ordinateur à une prise de terre. 
S’assurer que cette prise est conforme 
à la réglementation IEC (International 
Electrotechnical Commission).

Figure 4.  CellASIC® ONIX Microfluidic System back panel connection ports

Micro�uidic Perfusion System

Vacuum Power Ready Sealed To Micro�uidic Plate

USB
Pressure 100V - 240V ACVacuum

A B C D



CellASIC® ONIX Microfluidic Platform10

3. The CellASIC® ONIX Microfluidic System has an internal pump to supply air and 
vacuum. A toggle switch (F in Figure 5) on the front of the system turns the vacuum on 
and off.

Micro�uidic Perfusion System

Vacuum Power Ready Sealed To Micro�uidic Plate

E F G H I

Figure 5.  CellASIC® ONIX Microfluidic System front panel

E Power switch (  = ON)

F Vacuum switch  
(UP = ON)

G Power indicator  
(lit when system power 
is on)

H Ready light (lit when 
system is ready)

I Plate seal indicator (lit 
when plate is sealed)

As an alternative for more quiet and stable operation, external air and vacuum lines 
can be connected at the back of the system. Air pressure input should be 2.1–6.9 
bar (30–100 psi), and vacuum input higher than 711 millibar (21 in. Hg). If you wish 
to connect external air and vacuum, use the fittings provided in the accessory box 
(CPC 4 mm valved coupling insert). Attach the vacuum line to the Vacuum input (B 
in Figure 4) and the air line to the Pressure input (C in Figure 4) on the back of the 
system.

4. Securely attach the vacuum Luer fitting (black) and eight pressure Luer filters 
(translucent) from the manifold to the Luer fittings on the front panel of the system in 
the correct order (Figure 6).

Figure 6.  Tubing attachment to system

To gas outlet 
 on MIC230  

or GM230

Important: Match each fitting to the corresponding line. Black fitting must be matched 
to black line (Figure 6). Before starting each experiment, make sure all 
eight Luer filters are securely attached to the fittings. At the same time, 
check to see that there is no liquid contamination in the manifold tubing 
and/or filter. If contamination is detected, clean out tubing and replace 
Luer filter(s) according to sections 11.4 and 11.5.

6.4 CellASIC® ONIX Microfluidic System Setup, continued 
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The separate white fitting is for use with the CellASIC® ONIX Microincubator Controller 
or Tri-Gas Mixer. If neither of these components is being used, this fitting does not 
need to be connected.

5. Turn on power switch (E in Figure 5). The blue Ready indicator (H in Figure 5) will light 
up when the unit is ready for operation.

6.5 Gasket/Manifold Assembly
If gasket is detached from the manifold, assemble using the following method:

1. Check cleanliness of the gasket; lint and particles may affect instrument operation. To 
clean the gasket, follow instructions in section 11.3.

2. Match the outline shape of gasket to manifold.

3. Align and insert gasket oval lip into the manifold viewing oval (follow red arrows in 
Figure 7).

4. Make slight adjustments to gasket/manifold position so gasket and manifold align hole-
to-hole (dotted black arrows in Figure 7). Do not stretch gasket.

5. Lay gasket flat onto manifold surface.

   

Gasket oval lip

Manifold viewing oval

Figure 7.  Attachment of gasket to manifold

6.6 Plate/Manifold Sealing
1. Wipe the F84 manifold gasket with 70% ethanol and dry with a lint-free cloth.

2. Place the microfluidic plate on a flat surface.

3. Align and set the manifold over the wells of the plate.

4. Make sure that the blue Ready light on the system is lit.

5. Turn the vacuum on (toggle switch up) and push down on the locations indicated in 
Figure 8 with slight force for ~5 seconds to ensure uniform contact during sealing. 
When a proper seal is formed, the green Sealed light will be lit.

6.4 CellASIC® ONIX Microfluidic System Setup, continued 
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Figure 8.  Sealing the plate to the manifold

If this light does not appear, turn off the vacuum. Wait for the blue Ready light to turn 
back on, then repeat step 5. If a seal cannot be formed, contact Technical Service.

Make sure that a proper seal is formed before starting any experiment.

Leave the vacuum on during the course of the experiment.

6.7 System Diagnostics
To ensure that the system is installed and running properly, run the system diagnostic test.

1. Seal the manifold to the diagnostic plate supplied in the accessory box (refer to Plate/
Manifold Sealing, section 6.6).

2. Open the CellASIC® ONIX FG Software and go to System→System diagnostic  
(Figure 9).

Figure 9.  System diagnostic

6.6 Plate/Manifold Sealing, continued
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3. Enter the catalogue number (262) and serial number located on the back of the system. 
Click Run (Figure 10).

Figure 10.  Enter serial number

4. If all 5 status boxes are checked off, then the system is ready to go (Figure 11). Click 
on Quit diagnostic to leave this screen. If all the boxes are not checked off, save the 
results and contact Technical Service.

Figure 11.  System ready to go

6.7 System Diagnostics, continued
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6.8 Operation
1. Place the plate/manifold assembly on an inverted microscope. Focus on the center of 

the viewing area. (Figure 12). The culture chamber size varies from plate to plate. Refer 
to the specific plate User Guides for dimensions.

Figure 12.  Microfluidic plate viewing area

Viewing area

2. Open the CellASIC® ONIX FG Software on the computer and select the appropriate 
plate type (refer to section 7.1).

7 CellASIC® ONIX FG Software Interface
The CellASIC® ONIX FG Software is an easy-to-use interface for automating experimental cell culture 
protocols.

7.1 Plate Selection
After opening the CellASIC® ONIX FG Software, select the plate of choice using the option 
tabs (Mammalian, Yeast, or Other) on the start screen (Figure 13). Each tab has multiple 
plate types below it.

Figure 13.  Start screen plate selection



CellASIC® ONIX Microfluidic Platform 15

The functions and features of the software will be demonstrated using the M04S plate. 
After this plate is selected from the start screen, a 2-part window appears. The left side 
controls manual operation of valves V1–V8, and the auto operation mode on the right side 
provides various options for programming, logging, and running experimental protocols 
(Figure 14). To operate in either manual or auto mode, make the appropriate selection on 
the plate screen.

Figure 14.  M04S plate window

Individual valve 
controls/display 

Manual/Auto 
mode selection

Status indicator 

Flow gauges 

7.2.1 Manual Mode

When Manual mode is selected on the left screen, automatic functions on the 
right will disappear. Choose either Plate View or Unit View in the Options drop-
down menu (Figure 15).

Figure 15.  Manual mode, Plate/Unit view options

7.2 Key Features and Functions - Description of Auto and Manual Mode
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Plate View: In the Plate View interface (Figure 16), the orange- and blue-colored 
bars labeled V1–V8 represent the eight controllable valves. Flow through each 
valve to the wells is set by clicking on the colored bar (when active, the bars 
appear darker in color) and adjusting the pressure using the flow gauges. The 
valves can also be keyboard-activated using the F1 through F8 keys.

Figure 16.  Manual mode, plate view option

7.2 Key Features and Functions, continued
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Unit View: In the Unit View interface (Figure 17), the channel inlets for each 
solution are shown for each cell culture chamber. These can be turned on and off 
by clicking the valve (V) of interest or using the F1 through F8 keys.

Figure 17.  Manual mode, unit view option

Flow gauges 

Status indicator 

Flow X and Y 
linkage box

Flow Gauges: The two flow gauges (Figure 17) control the pressure applied to 
the activated wells, resulting in a defined flow rate of a given solution. Two 
independent pressures can be set: Flow X corresponds to the pressure applied to 
the orange-colored valves V1 and V2. Flow Y corresponds to the pressure of the 
blue-colored valves V3 through V8. Click and drag the flow gauge bar or type in 
the desired pressure to adjust the pressures. The pressures of Flow X and Y can be 
linked during manual operation by checking the linkage box (Figure 17).

System Status: The system status indicator (Figure 17) reports the system 
connectivity and microfluidic plate seal.

7.2 Key Features and Functions, continued
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7.2.2 Auto Mode

Auto mode allows the user to control the right side, or command view, of 
the interface window. The command view provides different options/tabs for 
programming, logging, and running experimental protocols (Figure 18). While 
the left side of the screen cannot be toggled manually, it still displays status and 
graphically demonstrates each step of the experiment while a protocol is running.

Figure 18.  Command view

Experiment Design: This tab offers the option of recording experiment information 
such as cell type, concentration, media type, etc. with the experiment protocol. 
Fill out the provided boxes according to plate well location, then, click Add To 
Protocol (Figure 19). The information entered will appear in the protocol code as 
notes.

Figure 19.  Print experiment drop-down menu

7.2 Key Features and Functions, continued
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The screen can be printed by choosing Print experiment in the File drop-
down menu (Figure 19). It can also be saved using the same steps but selecting 
PDFCreator as the printer. The print out/PDF file contains three pages of materials: 
a page for the Experiment Design tab, a page for the Load Cells tab, and a page 
for the Create Protocol tab (Figure 20).

Figure 20.  Print experiment files

Press the Skip button or click on the next tab if you choose to record experiment 
information elsewhere.

7.2 Key Features and Functions, continued
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Load Cells: This tab allows you to create a program for loading a cell suspension 
into the culture chamber via the indicated wells. Well location and loading 
parameters differ from plate type to plate type (Figure 21).

NOTE: Using the default setting specific to each plate is recommended, however, 
optimization may still be required depending on the cell type and/or 
concentration. For some plates types, cell loading can be achieved without 
using the software and controller. For example, the M04S-03 microfluidic 
plates can be gravity-loaded by pipette. In such cases, this cell loading tab 
can be skipped.

Figure 21.  Load Cells tab

7.2 Key Features and Functions, continued
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Create Protocol: This tab can be used to program experiments involving sequential, 
time-dependent solution exposure. You can specify the solution inlet valve  
(V1–V6), flow (psi), and duration of exposure (HH:MM:SS) for each step of the 
experiment (Figure 22).

Set up the desired protocol parameters, then, if you wish to save the file, click on 
File→Save protocol.

NOTE: The protocol will also be saved in the ONIX FG Folder (section 7.4) once you 
click Create Protocol AND Run in the next tab.

Figure 22.  Create Protocol tab

7.2 Key Features and Functions, continued
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Click on the Create Protocol button, then click on OK on the pop-up window 
(Figure 23). This will automatically take you to the Run Protocol tab.

NOTE: Clicking OK on the pop-up (Figure 23) will not erase the protocol that was 
just created. It will overwrite any previous protocol or default values.

Figure 23.  Create Protocol button

7.2 Key Features and Functions, continued
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Run Protocol: This tab converts your protocol into code recognized by the flow 
controller. Protocols created using the Create Protocol tab can be viewed and 
edited here (Figure 24), and information entered using the Experiment Design 
tab will appear as notes. New protocols can also be written and saved. Previous 
protocols can be loaded by clicking File on the taskbar and choosing the desired 
action from the drop-down menu.

Figure 24.  Run protocol tab

To proceed, click on the Test button. The duration of the protocol (Figure 25) will 
appear in a popup window.

7.2 Key Features and Functions, continued
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Figure 25.  Experiment protocol test

7.2 Key Features and Functions, continued
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7.2 Key Features and Functions, continued

At this time, if the email alert function has been enabled in the System drop-
down of the start screen, choose to receive the email alert by checking the Send 
me email alert box (Figure 26). Enter the desired recipient email address onto the 
pop-up screen. If the email setting is not enabled, the Send me email alert check 
box will be grayed out. See section 7.5 for setup instructions.

Figure 26.  Email alert check box

To run the protocol, click on the Run button (Figure 26).
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The program can be stopped or paused using the Stop and Pause buttons 
(Figure 27). Pausing the program allows the plate to be unsealed and removed from 
the manifold for addition/removal of solutions from the wells, if required. 

Figure 27.  Stop and Pause buttons

NOTE: When the program has been “paused”, you have the option to stop it 
entirely so that it can be aborted or restarted from the beginning, or to 
resume it where you left off.

The plate can then be resealed to the manifold and the program resumed using the 
Resume button (Figure 28).

Figure 28.  Resume button

7.2 Key Features and Functions, continued
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Mini View: The Mini View button of the Run Protocol screen shrinks the software 
interface into a status bar in the lower right hand corner of the screen (Figure 29). 
The Mini View window will display current protocol status by indicating whether 
the protocol is running, time until the end of protocol, and read temperature if the 
MIC230 Microincubator Controller is connected. Click on the >> button to return 
to Run Protocol screen.

Figure 29.  Current Protocol Status (Mini View)

Plot View: During an experiment, the software will plot the history of perfusion 
sequences (Figure 30). To view, click on Options→Show Plot. The plot may also 
be exported using the command File→Export data (hotkey Ctrl+S) or File→Open 
history (hotkey Ctrl+O).

Figure 30.  Plot view

7.2 Key Features and Functions, continued
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7.2.3 Glossary of Commands:
The following commands are used to program experimental protocols.

Command Range Function
setflow X n n = 0.25–10 (psi) Sets flow on X (orange)
setflow Y n n = 0.25–10 (psi) Sets flow on Y (blue)
settemp n n = 20–45 (°C) Sets temperature for MIC230 

Microincubator Controller
open Vn n = 1, 2, 3, 4, 5, 6, 

7, or 8
Opens pneumatic valve

close Vn n = 1, 2, 3, 4, 5, 6, 
7, or 8

Closes pneumatic valve

wait n n = minutes Holds current condition until next step
end N/A Ends the program; shuts off all valves and 

resets regulators
% (followed 
by space)

N/A Put at the beginning of a line to create a 
comment

To vary flow rates between steps:

Insert the setflow X n or setflow Y n command before desired step. Use setflow 
X n to change the flow rate of solution in the wells controlled by V1 and V2 (i.e., 
A1–D1, and A2–D2). Use setflow Y n to change the flow rate of solution in the 
wells controlled by valves V3–V8 (i.e., A3–D3, A4–D4, A5–D5, A6–D6, A7–D7, and 
A8–D8). Use both commands in succession to change the flow rate of all wells.

NOTE: All subsequent steps will flow at the set rate. To revert back to a flow rate, 
you must insert additional setflow commands before the next step.

7.3 Sample protocol
The following example shows the code for a simple solution-switching protocol. The 
contents of the plate wells are as follows:

V1 V2 V3 V4 V5 V6 V7 V8

Well (A1) contains 300 µL red solution

Well (A2) contains 300 µL orange solution

Well (A3) contains 300 µL yellow solution

Well (A4) contains 300 µL blue solution

Well (A5) contains 300 µL purple solution

Well (A6) contains 300 µL clear solution

7.2 Key Features and Functions, continued
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Code

% Constant flow rate pressure of 2 psi
setflow X 2.0000
setflow Y 2.0000

% Step 1: Expose chamber to red solution for 60 minutes
open V1
wait 60
close V1

% Step 2: Expose chamber to orange solution for 60 minutes
open V2
wait 60
close V2

% Step 3: Expose chamber to yellow solution for 60 minutes

open V3

wait 60

close V3

% Step 4: Expose chamber to blue solution for 60 minutes
open V4
wait 60
close V4

% Step 5: Expose chamber to purple solution for 60 minutes
open V5
wait 60
close V5

% Step 6: Expose chamber to clear solution for 60 minutes
open V6
wait 60
close V6

% End experiment protocol
end

7.3 Sample Protocol, continued
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7.4 ONIX FG Folder
Once the CellASIC® ONIX FG software is installed, a folder named ONIX FG is 
automatically created as a central location to log files (Figure 31). The folder can be found 
in C:\Users\Public\Documents.

Figure 31.  ONIX FG folder

After clicking Run on the Run Protocol tab, the CellASIC® ONIX FG software automatically 
saves the protocol code and plot for each experiment. These two files are bundled into a 
folder named by the date and time the experiment was initiated. For example, protocol and 
data for an experiment started on January 1, 2000 at 04:29:19 p.m. is stored in a folder 
named “20000101162919”.

7.4.1 Protocol
Protocol codes are saved as .txt file. They can be loaded into the CellASIC® ONIX FG 
software by going to File→Open protocol in the Run Protocol window. The file 
can also be opened in a text-only editor such as Notepad.

7.4.2 Plot
Plots are saved as .onix files. They can only be viewed properly in the Plot View 
window of the CellASIC® ONIX FG software. Access a specific plot from the Plot 
View window by going to File→Open plot.
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7.4.3 Report Log
The Report Log is a .txt file that presents a history of the ONIX Microfluidic System 
by automatically logging the status of the instrument. It is especially useful to 
send the Report Log along with diagnostic test results to Technical Service when 
encountering an error.

7.5 Email Alert
Email alerts can be sent through the CellASIC® ONIX FG Software to specified recipients 
when a protocol is completed or disrupted. In order to do this, an outgoing email address 
and mail server must be specified in System→Email alert on the start menu. This 
outgoing email address/server will be saved and act as the sender email address in all 
communications from the CellASIC® ONIX FG Software-specified recipients until another 
email address/server is entered. If the ONIX platform is shared among different users, it is 
recommended that a shared sender’s email address be set up to avoid confusion.

NOTE: Please check your local network connectivity and firewall settings to allow Email 
Alert capability on the CellASIC® ONIX FG Software.

Figure 32.  Email alert settings

Fill out all fields in the Email Alert Settings pop-up window according to email service 
provider (Figure 32). Below are example settings for some of the most commonly used 
email services. If in doubt, please check with your email service provider.

7.4 ONIX FG Folder, continued
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Email service provider:

Gmail™
Outgoing Mail Server (SMTP): smtp.gmail.com
Port: 587
Sender’s Email Address: Gmail™ address of your or your group’s choosing to send the alerts
Username: Full Gmail.com email address (same as above)
Password: Gmail™ password for this account

Outlook®
Outgoing Mail Server (SMTP): smtp.live.com
Port: 587
Sender’s Email Address: Outlook® email address of your or your group’s choosing to send 
the alerts
Username: Full Outlook.com email address (same as above)
Password: Outlook.com password for this account

Comcast®
Outgoing Mail Server (SMTP): smtp.comcast.net
Port: 587
Sender’s Email Address: Comcast® email address of your or your group’s choosing to send 
the alerts
Username: Full Comcast® email address (same as above)
Password: Comcast® password for this email account

Yahoo!®
Outgoing Mail Server (SMTP): smtp.mail.yahoo.com
Port: 587

Sender’s Email Address: Yahoo!® email address of your or your group’s choosing to send the 
alerts
Username: Full Yahoo!® Mail email address (same as above)
Password: Yahoo!® Mail password for this email account

AT&T®
Outgoing Mail Server (SMTP): smtp.mail.att.net
Port: 587
Sender’s Email Address: AT&T® email address of your or your group’s choosing to send the 
alerts
Username: Full AT&T® email address (same as above)
Password: AT&T® password for this email account

7.5 Email Alert, continued
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Click the Enable email alert capabilities box on the bottom of the window (Figure 33). 
The software will attempt to establish internet connection. If connection is made, check 
the setup by clicking Send Test Email. The Enter recipient email address pop-up will 
appear. Enter the address you’d like to receive the email at and click OK to send test email 
(Figure 33).

Figure 33.  Enter recipient email address pop-up

The ONIX FG software will indicate whether the email was sent successfully. If successful, 
a test email using the sender’s email address will appear in the recipient’s inbox with the 
subject “EMD Millipore – ONIX Email Test”.

After confirmation of receiving the email, click OK to complete Email Alert setup.

7.5 Email Alert, continued
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8 CellASIC® ONIX Microincubator Controller
8.1 Introduction

The CellASIC® ONIX Microincubator Controller and Microincubator Manifold provide a 
convenient solution for temperature and gas environmental control to the CellASIC® ONIX 
Microfluidic System.

Micro�uidic Perfusion System

Vacuum Power Ready Sealed To Micro�uidic Plate

MicroIncubator Controller

Gas Flow To Heater Gas Out°C

37.0

Figure 34.  CellASIC® ONIX Microincubator Controller setup

NOTE: Microscope function and image 
acquisition are not integrated 
with or provided by the 
CellASIC® ONIX FG Software.

Taking advantage of the small size and thermal mass of the system, temperature control 
is achieved using an on-manifold, bi-directional, convective heat exchange module where 
recirculating air gently and uniformly warms or cools the cells.

NOTE: For immersion objectives and air objectives with a working distance less than 
0.5 mm, it is necessary to warm the objective using an objective heater (see 
section 8.3.2).

Gas control is achieved using highly accurate external premixed gas sources. The system 
purges the cell culture region at a gas consumption rate of only 3 mL/minute.

Figure 35.  Microincubator manifold and plate cutaway 

Convective Peltier 
heat exchanger

#1.5 thickness  
(170 µm) glass

Recirculating  
temperature-controlled  
gas mixture

Microfluidic 
plate Air pressure driven flow

Cells

34.5 mm

Manifold
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8.2 CellASIC® ONIX Microincubator Controller Setup
The following components are included in the CellASIC® ONIX Microincubator Controller 
package. Refer to the Product Ordering section for additional manifolds, accessories, and 
other components.

Component Catalogue Number
CellASIC® ONIX Microincubator Controller MIC230

CellASIC® ONIX Microincubator Manifold F84-HG4

Accessory box for CellASIC® ONIX MIC230 Microincubator 
Controller (includes temperature calibration plate, input 
fittings, 8-pack replacement Luer filters)

ABI1

1. Place the Microincubator Controller under the Microfluidic System within 1–2 meters 
of an inverted microscope. For best results, locate both control boxes on a flat surface 
and secure the manifold tubing so that it does not hinder stage movement. Ventilation 
holes should not be obstructed.

2. Connect the power cord from a grounded electrical outlet to the Microincubator 
Controller (C in Figure 36). The internal power supply accepts any voltage source 
between 100 and 240 VAC. Connect the USB cable from the computer to the USB port 
(A in Figure 36) on the back panel of the controller.

Figure 36.  Back panel connection ports

A B C

USB
100V - 240V AC

MicroIncubator Controller

Gas (45-55 psi)

Gas Flow To Heater Gas Out°C

If gas environmental control is desired, connect a premixed gas tank to the back of 
the controller (B in Figure 36) using the fittings (CPC 4 mm valved coupling insert) 
provided in the Microincubator Controller accessory box. The pressure must be 
regulated between 3.1 and 3.8 bar (45 and 55 psi). When the Microincubator Controller 
is powered on, consumption of the gas mixture will be approximately 3 mL/min.

NOTE: Use low gas-permeable tubing such as polyurethane or polyethylene.  
DO NOT use vinyl or silicone tubing.
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3. Securely attach the vacuum Luer fitting (black) and eight pressure Luer filters 
(translucent) from the manifold to the Luer fittings on the front panel of the system in 
the correct order (refer to Figure 6).

Important: Match each fitting to the corresponding line. Black fitting must be matched 
to black line. Before starting each experiment, make sure all eight Luer 
filters are securely attached to the fittings. At the same time, check to see 
that there is no liquid contamination in the manifold tubing and/or filter. 
If contamination is detected, clean out tubing and replace Luer filter(s) 
according to section 11.4 and 11.5.

Attach the white Luer fitting to the white Gas Out fitting (I in Figure 37) on the front 
panel of the Microincubator Controller. To connect the 6-conductor plug from the 
Microincubator Manifold, align the red marks and push into the socket labeled To 
Heater (H in Figure 37) on the front of the controller. The plug can be removed by 
pulling on the sheath.

Micro�uidic Perfusion System

Vacuum Power Ready Sealed To Micro�uidic Plate

MicroIncubator Controller

Gas Flow To Heater Gas Out°C

37.0

D FE G H I

Figure 37.  CellASIC® ONIX Microfluidic System and  
Microincubator Controller front panels

D Power switch (  = ON)

E Temperature setpoint 
adjustments

F Temperature display

G Gas flow confirmation 
(lit when gas is flowing)

H Heater connection

I Gas outlet connection

8.2 CellASIC® ONIX Microincubator Controller Setup, continued
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To confirm communication between the computer and the Microincubator Controller, open 
the CellASIC® ONIX FG Software and go to System→Reset communication. A pop-up 
window will indicate successful communication with both the EV262 and MIC230 control 
boxes (Figure 38).

Figure 38.  Confirming Microincubator Controller communication with computer

8.3 Temperature Calibration
A Temperature Calibration Plate is included in the accessory box provided with the 
Microincubator Controller. The Calibration Plate is used to confirm that the cell culture 
region is being maintained at the desired temperature despite room temperature variation 
and the heat sink capacity of the microscope objectives.

Attach the USB cable of the Temperature Calibration Plate found in the accessory box to 
the USB port of the computer.

Go to the Start screen of the CellASIC® ONIX FG Software and click on System→ 
Temperature calibration (Figure 39). A plot with calibration instructions will appear 
(Figure 40).

Figure 39.  Calibration drop down menu

8.2 CellASIC® ONIX Microincubator Controller Setup, continued
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Follow these steps to determine the correct Microincubator Controller setpoint for your 
experiment.

8.3.1 For air objectives with working distance greater than 0.5 mm:

1. Seal the Microincubator Manifold to the Temperature Calibration Plate as in 
section 8.5.

2. Place the manifold and plate onto the microscope stage and set up the 
microscope as it will be set up for the cell-based experiment. Correctly position 
the objective and condenser, and move the stage and objective to focus on the 
features within the viewing region of the Temperature Calibration Plate.

3. Turn on the Microincubator Controller and adjust the setpoint using the up and 
down arrows (E in Figure 37) on the controller front panel, until the readout 
displays the desired temperature for the experiment.

NOTE: While you are adjusting the temperature with the up and down arrows, 
the setpoint temperature is displayed on the controller (F in Figure 37). 
A few seconds after you stop adjusting the temperature, the current 
temperature of the Microincubator Manifold is displayed.

4. Allow the temperature of the Temperature Calibration Plate to stabilize. 
This may take up to 20 minutes and can be monitored in the temperature 
calibration window (Figure 40). If the stabilized temperature of the plate is 
not at the desired temperature for the experiment, adjust the setpoint up or 
down and wait for stabilization. Several adjustment/stabilization cycles may be 
required to bring the Calibration Plate temperature to the desired temperature. 
The temperature required to bring the Calibration Plate to the desired 
experimental temperature is the Microincubator Controller setpoint you will 
use for your experiment.

8.3 Temperature Calibration, continued
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Figure 40.  Temperature calibration screen

v iewing

8.3.2 For immersion objectives and air objectives with working distance 
less than 0.5 mm:
Objective heater required!

1. Seal the Microincubator Manifold to the Temperature Calibration Plate as in 
section 8.5.

2. Place the manifold and plate onto the microscope stage and set up the 
microscope as it will be set up for the cell-based experiment. Correctly position 
the condenser and stage, but do not have the objective near the plate.

3. Follow steps 3 and 4 in section 8.3.1 to determine the Microincubator 
Controller setpoint.

4. Bring the objective close and focus on the features within the viewing region of 
the Temperature Calibration Plate. Adjust the setpoint of your objective heater 
until the Temperature Calibration Plate is again at the desired temperature. 
Stabilization time depends on the objective heater. Use this objective heater 
setpoint for your experiment.

8.3 Temperature Calibration, continued
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8.4 Gasket/Manifold Assembly
Attach gasket to Microincubator Manifold as indicated in section 6.5.

8.5 Plate/Manifold Sealing
Seal the Microincubator Manifold to the microfluidic plate as indicated in section 6.6. 
Apply slight force at the positions indicated below to ensure uniform contact during 
sealing.

Figure 41.  Sealing the plate to the manifold

8.6 Operation
1. Turn the Microincubator Controller power switch on to begin heating or cooling the 

manifold.

If pressurized gas is supplied to the back of the Microincubator Controller, gas will flow 
from Gas Out while the power switch is on. A green Gas Flow indicator light (G in 
Figure 37) confirms that there is gas flow.

IMPORTANT: Due to the low gas flow rate (3 mL/min), the system needs approximately 
10 minutes to stabilize and provide a correct indication of gas flow 
status.
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2. Open the CellASIC® ONIX FG Software and choose the appropriate plate type.

NOTE: When the Microincubator Controller is connected to the system, the Set, Read, 
and Protocol set temperature boxes are enabled (Figure 42), and adjustments 
cannot be made manually on the controller.

Figure 42.  CellASIC® ONIX FG Software temperature control

Protocol setpoint

Current manifold  
temperature

3. Using the software, adjust the Microincubator Controller setpoint to the temperature 
determined from the Temperature Calibration Plate as follows:

Manual Operation tab: Click on the Set temperature up and down arrows or type in 
the desired value on the left side of the screen.

Create Protocol tab: Type the desired temperature into the box next to Protocol set 
temperature on the right side of the screen.

Run Protocol tab: Enter as command “settemp n” on the right side of the screen (refer 
to section 7.2.3).

NOTE: The setpoint temperature input on the right hand side of the screen in either 
the Create Protocol or Run Protocol tabs will override the Set temperature 
on the left side of the screen as soon as you click on the Run button.

8.6 Operation, continued
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9 CellASIC® ONIX Tri-Gas Mixer
9.1 Tri-Gas Mixer Setup

1 11

Tri-Gas Mixer

Air CO  2N2

Out

Figure 43.  CellASIC® ONIX Tri-Gas Mixer setup

NOTE: Microscope function and 
image acquisition are not 
integrated with or provided 
by the CellASIC® ONIX FG 
Software.

NOTE: Flow meter accuracy and stability are dependent on the pressure stability of gas 
inputs, levelness of surface, and degree of temperature fluctuation. 

1. Place Tri-Gas Mixer close to the CellASIC® ONIX Microfluidic System on a level surface.

2. Turn knobs all the way off before flowing gases.

IMPORTANT: Make sure that the knobs are always completely shut off before 
connecting gas lines. If a particular gas line is not in use, keep the knob 
shut at all times to ensure accuracy of measurement.

3. Connect external gas lines to corresponding inlets on the back of the Tri-Gas Mixer 
using the fittings provided.

4. Attach the Luer fittings from the manifold to the Luer fittings on the front panel of the 
system in the correct order. Refer to Figure 6.

Important: Match each fitting to the corresponding line. Black fitting must be matched 
to black line.

5. Attach white Luer fitting from the manifold to Tri-Gas Mixer outlet (Figure 44).

1 11

Tri-Gas Mixer

Air CO  2N2

Out

Figure 44.  Manifold to Tri-Gas Mixer connection
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6. Start turning the knobs counterclockwise on flow meters to set each gas to desired 
flow rate ratio. For most accurate flow measurement, set ratio to upper limit of flow.

7. Wait one hour for flow meter readings to stabilize. Make adjustments if necessary. 
Check/readjust flow every 72 hours to prevent drift.

9.2 Tri-Gas Mixer Examples

9.2.1 5% CO2

1. Follow setup instructions in section 9.1.

2. Set flow meters as indicated in Figure 45.

Figure 45.  Flow setting example 1; 5% CO2

Set CO2 flow rate to 5 mL/minSet either air OR N2 (for anoxic condition) flow rate to 95 mL/min
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9.2.2 Hypoxic Condition 1% O2, 5% CO2

1. Follow setup instructions in section 9.1.

2. Set flow meters as indicated in Figure 46.

Figure 46.  Flow setting example 2; Hypoxic condition 1% O2, 5% CO2

Set CO2 flow rate to 5 mL/minSet air flow to rate to 5 mL/min* Set N2 flow to rate to 90 mL/min
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* Concentration of O2 in air is 20.9%

9.1 Tri-Gas Mixer Setup, continued
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10 Troubleshooting
Symptom Cause Corrective Action
1. Microfluidic plate does 

not seal or leakage 
error message occurs

Manifold not settled properly 
around plate 

Align gasket hole-to-hole with manifold. Place lip 
of manifold over microfluidic plate properly. 

Gasket not aligned properly

Loose manifold Luer fittings/
filters

Tighten Luer fittings and filters as indicated in 
section 6.4.

Debris on gasket Clean gasket as indicated in section 11.3. Always use 
a lint-free cloth when wiping or blotting gasket.

Vacuum reservoir empty (Blue 
Ready indicator light is not 
illuminated)

Switch Plate Seal switch to off position and allow 
vacuum indicator light to re-establish. 

Manifold cracked or possible 
air leakage out of manifold

Run diagnostic program, save results, and contact 
Technical Service.

Luer fittings not in correct 
order

Connect Luer fittings consecutively along the length 
of the panel.

Plate leakage Check plate for cracks. If cracks are found, contact 
Technical Service.

2. Software unresponsive Interrupted communication 
between PC and CellASIC® 
ONIX Microfluidic System

Unplug and replug USB cable to re-establish USB 
connection, then restart software on PC.
Go to System→Reset Communication.

Computer does not support 
software requirements

Ensure that computer meets requirements listed in 
section 12.

3. Email Alert 
unresponsive

Connection to server failed Check information entered, internet connection, 
and firewall settings.

4. No Email Alert 
received

Connection to server failed Check information entered, internet connection, 
and firewall settings.

Email placed in junk folder Confirm that sender address is not blocked by 
recipient email.

5. Loud buzzing from 
CellASIC® ONIX 
Microfluidic System

Plate not sealed correctly See Symptom #1.
Loose manifold Luer fittings/
filters

Tighten Luer fittings and filters as indicated in 
section 6.4.

Electronic controllers need 
calibration

Turn system off and on. Seal plate to 
manifold. Perform calibration by clicking on 
System→Calibration sequence in the CellASIC® 
ONIX FG Software. 

6. CellASIC® ONIX 
Microfluidic 
System turns off 
unexpectedly

Internal pump overheated 
(possible cause: vacuum 
switch left on when there was 
no plate sealed to manifold)

Allow system to cool for an hour before turning on 
again. Before operating, check manifold seal. 
Always turn vacuum off when there is no plate on 
the manifold.

7. Fluid in the manifold 
lines

Culture chamber outlet wells 
were not emptied and they 
overflowed

During extended experiments, pause the protocol 
and empty the chamber outlet wells. Refer to 
section 7.2.2. Clean tubing and replace filters 
according to sections 11.4 and 11.5.
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Symptom Cause Corrective Action
8. Microincubator 

Controller not 
recognized by or 
communicating with 
software

Interrupted communication 
between PC and 
Microincubator Controller

Unplug and replug USB cable to re-establish USB 
connection, then restart software on PC.
Go to System→Reset Communication. If problem 
persists, restart ONIX FG Software.

9. Microincubator 
temperature control 
will not reach 
setpoint

Potential issue with heat 
exchanger module

Contact Technical Service.

10. Microincubator gas 
flow indicator does 
not illuminate

Insufficient time for a correct 
reading

Wait 10 minutes and if indicator light remains off, 
check for other causes.

No gas connected to 
controller

Connect 3.1–3.8 bar (45–55 psi) gas to back of 
system.

Manifold tubing is pinched Ensure that tubing is not pinched and that gas flow 
is unobstructed.

If these corrective actions do not resolve the issue, run the diagnostic test (section 6.7). Save the results 
and contact Technical Service.

10 Troubleshooting, continued
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11 Storage, Maintenance, and Cleaning
Y  WARNING Y  ATTENTION

Perform only the maintenance procedures 
described in this manual and observe the relevant 
safety precautions. Failure to do so may cause 
property damage or personal injury.

Maintenance or repair procedures not described 
in this manual should be performed only by an 
EMD Millipore Corporation service engineer. 
Tampering with or alterations to the CellASIC® 
ONIX Microfluidic System, Microincubator 
Controller, Manifolds and/or other components 
may void the warranty. Refer to the Technical 
Assistance section for information on contacting 
Technical Service.

Ne réaliser que les opérations de maintenance 
décrites dans ce manuel et prendre les 
précautions de sécurité adéquates. Le non-
respect de ces exigences peut provoquer 
des dommages matériels ou des blessures 
corporelles.

Les procédures de maintenance ou de réparation 
non décrites dans ce manuel doivent être réalisées 
uniquement par un ingénieur de maintenance 
EMD Millipore Corporation. Trafiquer ou modifier 
le Système de microfluidique CellASIC® ONIX, le 
Régulateur du microincubateur, le Collecteur et/
ou d’autres composants est susceptible d’annuler 
la garantie. Se reporter à la section “Technical 
Assistance” pour de plus amples informations sur 
la façon de contacter notre Service technique.

11.1 Storage
Store at 5–35 °C in an upright position.

11.2 Cleaning the CellASIC® ONIX Microfluidic System and 
Microincubator Controller
Wipe control boxes clean of dust and remove any possible obstruction to ventilation. Do 
not allow liquid to enter the system while cleaning.

11.3 Cleaning the Manifold and Gasket
Remove the gasket from manifold periodically and clean gently with soap and water. Rinse 
with distilled water and/or 70% ethanol and shake off excess liquid. Lay gasket back onto 
manifold with holes properly aligned and allow to air dry. Do not stretch gasket during 
alignment.

For sanitization prior to experiment, wipe gasket and manifold lightly (i.e., do not soak) 
with 70% ethanol and blot dry with a lint-free cloth.

NOTE: Manifold components are not autoclavable.

The glass on the top of the Microincubator Manifold can be gently cleaned with 70% 
ethanol or a glass cleaner.
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11.4 Cleaning the Manifold Tubing
If fluid enters the manifold tubing during the course of an experiment, it should be 
cleaned as described below, and the filters must be replaced. A wet filter will interfere 
with proper functioning of the system.

1. Remove the Luer filter from any manifold tubing lines that need to be cleaned and 
discard it.

2. Fill a 10 mL syringe with distilled water or 70% ethanol and attach the Luer adaptor 
provided in the accessory box to the syringe.

3. Connect the syringe to the tubing line via the Luer adapter and push fluid through the 
tubing. To dry, fill syringe with air and push out residual fluid.

CAUTION: When cleaning the Microincubator Manifold tubing, keep the manifold right 
side up and level, and do not expose the heat exchange module to liquid.

MISE EN GARDE : Lors du nettoyage de la tubulure du collecteur du Microincubateur, 
conserver le collecteur à l’endroit et de niveau, et ne pas exposer le 
module d’échange de chaleur à des liquides.

11.5 Replacing Manifold Luer Filters
Should the Luer filter fittings become wet and/or contaminated, they can be replaced by 
simply twisting each filter off of the male Luer fitting, cleaning the tubing as described in 
section 11.4, and twisting on replacement filters (Figure 47). Discard wet/contaminated 
filters, as they cannot be cleaned or reused.

Figure 47.  Luer filter replacement

Replacement filters are included in the accessory boxes that come with each system, and 
can be ordered separately as needed. See section 13 for ordering information.
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12 Specifications
12.1 EV262 Microfluidic System

General
Dimensions 310 mm wide × 257 mm deep × 113 mm high  

(12.2 in. × 10.1 in. × 4.4 in.)
Weight Controller: 5.4 kg (11.9 lb) 

Manifold: 0.12 kg (0.26 lb)
Power consumption 100–240 VAC, 50/60 Hz
Power rating 40 W
Cooling mode Air cooled (natural convection)
Environmental conditions For indoor laboratory use 

Operating temperature: 20 °C to 30 °C 
Storage temperature: 5 °C to 35 °C

Outputs
Number of outputs 8
Pressure range 0–0.7 bar (0–10 psi)
Pressure accuracy ± 17.2 mbar (0.25 psi)
Pressure stabilization time < 5 seconds

Optional inputs
Pressure supply Clean, dry air, nitrogen (N2), or argon regulated between  

2.1 and 6.9 bar (30 and 100 psi).
Vacuum Steady vacuum regulated between 711 millibar (21 in. Hg) 

and perfect vacuum
Gas mixture Flow rate of 3–100 mL/min

Cell Culture Region Gas Environment Accuracy
For gas flow at 3 mL/min 
For gas flow at 20 mL/min

< 10% deviation from delivered gas 
< 2% deviation from delivered gas

Computer Requirements
Operating system 
Random access memory (RAM) 
Hard drive 
Hardware interface

Windows® XP, Windows® 7, Windows® Vista, or Windows® 8 
1 GB or higher 
200 MB or higher 
USB 1.0 or higher 
Keyboard, mouse

Manifold Materials of Construction
Manifold body Cyclic olefin copolymer
Gasket Silicone
Tubing/fittings Polyurethane, polycarbonate, nylon, stainless steel, polytetra-

fluoroethylene (PTFE), glass
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12.2 MIC230 Microincubator Controller

General
Dimensions 310 mm wide × 257 mm deep × 50 mm high 

(12.2 in. × 10.1 in. × 2.0 in.)
Weight Controller: 2.7 kg (6 lb) 

Manifold: 0.23 kg (0.51 lb)
Power consumption 100–240 VAC, 50/60 Hz
Power rating 40 W
Cooling mode Air cooled (natural convection)
Environmental conditions For indoor laboratory use 

Operating temperature: 20 °C to 30 °C 
Storage temperature: 5 °C to 35 °C

Temperature Control
Temperature control range Room temperature to 37 °C
Control method Bi-directional PID
Set method Up and down keys, increment 0.1 °C
Achievable stability ± 0.5 °C
Rise time (25 °C to 37 °C) < 30 minutes
Cooling time (37 °C to 25 °C) < 30 minutes
Calibration plate accuracy ± 0.1 °C

Optional gas flow
Flow rate 3.0 mL/min typical, ± 0.5 mL/min
Premixed gas input Clean, dry, premixed gas containing air, CO2, N2, and oxygen (O2) 

up to 25%, regulated to 3.1–3.8 bar (45–55 psi)

Cell Culture Region Gas Environment Accuracy
For gas flow at 3 mL/min 
For gas flow at 20 mL/min

< 10% deviation from delivered gas 
< 2% deviation from delivered gas

Computer Requirements
Operating system 
Hardware interface

Windows® XP, Windows® 7, Windows® Vista, or Windows® 8 
USB 1.0 or higher

Manifold Materials of Construction
Manifold body Cyclic olefin copolymer
Gasket Silicone
Tubing/fittings Polyurethane, polycarbonate, nylon, stainless steel, PTFE, glass

12 Specifications, continued
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12.3 GM230 Tri-Gas Mixer

General
Dimensions 161.3 mm wide × 151.2 mm deep × 183.6 mm high 

(6.4 in. × 6.0 in. × 7.2 in.)
Weight 2.1 kg (4.6 lb)
Environmental conditions For indoor laboratory use 

Operating temperature: 15 °C to 30 °C 
Storage temperature: 5 °C to 45 °C

Gas supply requirements Compressed air, N2, and CO2 
Clean and dry, > 99.5% pure 
Regulated to 2.1–6.9 bar (30–100 psi)

Gas supply consumption Air, 0–100 mL/min 
N2, 0–120 mL/min 
CO2, 0–10 mL/min

Outputs
Mixed gas 0% or 1–21% O2 

0% or 1–15% CO2

Flow meter accuracy ± 2% of full scale at 21 °C
Flow meter stability ± 0.20% CO2 per 1 °C*
Flow meter drift ± 0.1% CO2 per day*

* Example application at 5% CO2 and ± 4 °C thermal oscillation

12 Specifications, continued
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13 Ordering Information
This section lists catalogue numbers for the CellASIC® ONIX products. See Technical Assistance section 
for contact information. You can purchase these products on-line at www.millipore.com/products.

Product Description Cat. No. Qty/Pk
CellASIC® ONIX Microfluidic System EV262 1

CellASIC® ONIX Microincubator Controller MIC230 1

CellASIC® ONIX Tri-Gas Mixer GM230 1

CellASIC® ONIX Manifolds
Manifold for use with CellASIC® ONIX plates F84-GL4 1
Manifold with recirculating heat exchanger, for use with CellASIC® 
ONIX plates and Microincubator Controller

F84-HG4 1

CellASIC® ONIX Software
CellASIC® ONIX FG User Interface Software 0NIX-FG-SW 1

CellASIC® ONIX Microfluidic Plates
CellASIC® ONIX switching plate for mammalian cells (4-chamber) M04S-03-5PK 5
CellASIC® ONIX open-top plate for mammalian cells (4-chamber) M04L-03-5PK 5
CellASIC® ONIX gradient plate for mammalian cells (4-chamber) M04G-02-5PK 5
CellASIC® ONIX plate for haploid yeast cells (4-chamber,  
trap heights of 3.5, 4.0, and 4.5 µm)

Y04C-02-5PK 5

CellASIC® ONIX plate for diploid yeast cells (4-chamber,  
trap heights of 5, 6, and 7 µm)

Y04D-02-5PK 5

CellASIC® ONIX plate for bacteria cells (4-chamber,  
trap heights of 0.7, 0.9, 1.1, 1.3, 2.3, and 4.5 µm)

B04A-03-5PK 5

CellASIC® ONIX plate for Chlamydomonas cells (4-chamber,  
chamber height of 5 µm with 4 µm pocket)

C04A-01-5PK 5

http://www.millipore.com/products
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Product Description Cat. No. Qty/Pk
CellASIC® ONIX Microfluidic System Replacement Parts/Accessories

Premixed gas regulator (for use with 103 L or 112 L cylinders with a 
C10 connection)

GR02 1

Humidity bottle HB01 1
Accessory box for MIC230 Microincubator Controller 
(includes temperature calibration plate, input fitting,  
8-pack replacement Millex® Luer filters)

ABI1 1

Accessory box for EV262 Microfluidic System 
(includes diagnostic plate, syringe Luer adapter, input fittings, 
8-pack replacement Millex® Luer filters)

ABN2 1

Replacement gasket for F84 manifolds F84-GK 1
Replacement Millex® Luer filters F84FH0408 8

CellASIC® ONIX Microfluidic Services
Installation, service, and warranty options available upon request

14 Technical Assistance
For more information, contact the office nearest you. In the U.S., call 1-800-221-1975. Outside the 
U.S., go to our web site at www.millipore.com/offices for up-to-date worldwide contact information. 
You can also visit the tech service page on our web site at www.millipore.com/techservice.

15 EC Representative
Millipore (UK) Ltd.  
Fleming Road, Kirkton Campus 
Livingston EH54 7BN 
UK

16 Standard Warranty
The applicable warranty for the products listed in this publication may be found at  
www.millipore.com/terms (within the “Terms and Conditions of Sale” applicable to your  
purchase transaction).

13 Ordering Information, continued
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